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Introduction 
 

Net Monitor for Employees lets you see what everyone's doing -   without leaving your 

desk. Monitor the activity of all employees. Plus you can share your screen with your 

employees   PCs, making demos and presentations much easier.  

 

What are the major benefits of using this employee monitoring 

software?  

 

 Installation and use of the application is very easy since all of the functions can 
be accessed with a few mouse clicks.  

 You have complete control over what employees are doing.  
 This application provides you with a live picture of the employee computer 

screens.  
 You can make the presentation by showing your live screen to students or 

presenting student screen to others.  
 Application allows you to take over the employee computer by controlling its 

mouse and keyboard.  

 The employee computers´ screens are represented in the table with a 

customizable number of rows as thumbnails.  
 Schedule employee computers desktop recording to MPEG4 files  
 Execute several actions on all employee computers with on click  
 Block applications and Internet access  
 Log visited web pages  
 Log used applications  

 ...and much more - see feature list and screen-shots 
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Main Features:  

 

 Displaying a live picture of an employee computer.  
 You can take control of an employee computer by controlling its mouse and 

keyboard.  
 More employee monitor screens can be displayed in a table.  
 Computers can be organized in computer groups (e.g. classrooms)  
 An employee monitor screen can be zoomed to an actual size.  
 The name of the connected user is displayed.  
 Record employee computers screens to MPG4 files.  
 Show your desktop to students or show student desktop to students  
 Power on/off, restart, hibernate, suspend employee computers  
 Log off desktop users  
 Lock workstation  
 Clear desktop  
 Control screen-saver  
 Block Internet  
 Block applications  
 Mute employee computers  
 Limit employee computers audio volume level  
 Disable printing  
 Disable Ctr+Alt+Del  
 Blank screen  
 Start program on employee computers and see the output  
 Open web page on employee computers  
 Multi-monitor support  
 Control over running processes and applications  
 You can lock selected employee computers  
 You can display a message on selected employee computers.  
 When lower bandwidth is required, the refresh interval can be enlarged.  
 Automatic connection to an employee computer is optional.  
 Settings for the agent are encrypted and password protected.  
 Connection to an employee computer is password protected.  
 Access to monitoring the console is password protected. If   more users use the 

same computer, different profiles and access   passwords can be set.  
 More monitoring consoles can be connected to the same employee computer - 

you can monitor your students from different locations.  

 Agent can be remotely installed.  

 Fast users switching is supported.  

 Multi-session support for Remote Desktop, Terminal Services, Citrix,...  

 Console can be used on smart phone or tablet  

  



 

Page | 5 

 

Install the Application  

 
The application consists of two modules that must be installed:  

 Net Monitor for Employees Professional Console  
 Net Monitor for Employees Agent  

 

Installing the Net Monitor for Employees Agent  

The "Net Monitor for Employees Agent" must be installed on all remote computers that 

you want to monitor. To do this, you must have administrative privileges.  

NOTE:  

On Windows XP, Windows Vista, Windows Server 2003 or Windows Server 2008 you 

need to install update from this web page:  
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http://support.microsoft.com/kb/971513  

Update has to be installed on all computers where agent is installed and is necessarily 

to successfully block web pages on various web browsers.  

Agent can be manually or remotely installed.  

Remote agent installation is possible only on NT based operating systems (Windows 

XP, Windows 2003, Windows 7,8,10) with administrative privileges. Please note that 

used port will be automatically open only on Windows Firewall. On all other firewalls you 

will have to open this port by your self. Remote installation can be done on LAN, WLAN 

or VPN. The remote installation over the Internet is not possible unless you use VPN 

network.  

Remote Agent Deployment over Active Directory  

MSI package for agent that can be used for remote deployment over Active Directory 

can be downloaded here:  

http://networklookout.com/dwn/nmemplpro_agent.msi  

It can be installed like this:  

msiexec /i nmemplpro_agent.msi PASSWORD=myAgentPassword /qn  

You need to deploy as usual using package nmemplpro_agent.msi and specifying a 

MSI property  

PASSWORD=myAgentPassword  

The myAgentPassword is the password you want to use.  

Manual Installation  

To manually install an agent please go to remote computer and run the installation 

program.  

In the first installation window click on second option Install "Net Monitor for Employees 

Agent".  

On the end of installation you will have to configure an agent. To do so please read the 

chapter Agent Configuration.  

Agent can be installed in stealth mode (select " Stealth Agent Install " checkbox).  

http://support.microsoft.com/kb/971513
http://networklookout.com/dwn/nmemplpro_agent.msi
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In such way no program group is created, application does not appear in Add/Remove 

programs and no icon is displayed.  

Agent Configuration  

 

During installation, you need to type the password that protects the configuration and 

access to the agent. Here, simply select one password and remember it. Note that the 

default port on which the agent operates is 4495. You can change this port during 

installation or, later on (Advanced Configuration tab). If you use a firewall, you must 

open the used port.  
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Remote Installation  

To start remote agent installations click with right mouse button on computer in a list.  

Object menu will appear:  

 

Choose Remote Agent Install / Unistall .  

After that this login screen will appear:  
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You have to enter the information about the user account on the remote computer that 

has administrator privileges.  

Installing the Net Monitor for Employees Agent on Terminal Services 

(RDP) Server  

Application can monitor individual TS (RDP) sessions. In this case agent has to be 

installed on Terminal Services Server using the same procedure as described in 

previous chapter.  

 

You need to add only server to the monitoring console because sessions will appear 

automatically.  

When adding server to console select "Advanced Options" and choose option "This 

computer is a terminal server (TS, RDP)":  

 

Installing Net Monitor for Employees Professional Console  

The "Net Monitor for Employees Professional Console" must be installed on one or 

more computers from which you want to monitor the remote computers.  

To do so, you must login to the computer - from where you want to monitor - as the user 

that uses this computer (or as administrator). Next, install the “Net Monitor for 

Employees Professional Console”. Start the console and type the password that you 
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want to use for accessing the console. If more users use the same computer, they must 

all login to the computer using their accounts and set their own password for the 

console.  
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Using the Console  
 

Administrator console is used to monitor employee computers. 

Adding Remote Computers in the Console  

To be able to monitor the remote computers, you must first add them to the console. 

You can add computers in three ways:  

 Add computers manually  

 Scan network for installed agents  

 Add group of LAN computers  

 

Use File menu to add computers:  

 

  

http://networklookout.com/help/using_console.htm#ADD_MANUALLY
http://networklookout.com/help/using_console.htm#SCAN
http://networklookout.com/help/using_console.htm#LAN
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Add Computers Manually  

Select "Add computer..." from File menu:  

The dialog has two tabs:  

Basic Options  

Advanced Options  

Basic  Options  

 

Remote computer (host or IP):  

Enter the network hostname or the IP of the remote computer. When using DHCP on 

the local network you must enter the computer name.  

Nickname:  

Enter the name that you want to be displayed to easily identify the remote computer.  

Agent’ password:  

In this field, enter the same password used when installing the agent.  

Advanced Options  
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TCP Port:  

In this field, enter the same port used when installing the agent. The default port is 

4495.  

Connect automatically:  

Mark this checkbox if the remote computer should be automatically connected when the 

“Net Monitor for Employees Professional Console” starts.  

Monitor:  

Select which monitor will be displayed as thumbnail.  

Multisession - terminal (TS, RDP) options :  

Select if your computer is RDP, TS server. This will allow you to see all remote 

sessions.  
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Scan Network for Installed Agents  

 

If you already installed agents on remote computers, you can scan the network and add 

them automatically.  
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Add Group of LAN Computers  

 

You can automatically add computers on your LAN. Agent can be installed remotely if 

your LAN permits this (e.g. if you are NT DOMAIN Administrator).  
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Remote Computers List  

 

The “Remote Computers List” displays all computers added. The computer icon 

displays the state of the remote computer. The commands above the remote computer 

can be easily accessed using the “Object Menu”, which can be invoked using a right 

mouse click.  

Computers can be organized in groups - use "Add computer group... "from File menu.  
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Monitor Remote Computers  
The "Remote Screens Tab" displays the screens (as thumbnails) of all remote 

computers.  

There are several configuration options available like thumbnail size, refresh interval, 

aspect ratio...  

 

Tools and Restrictions  
Tools can be used to perform various tasks on remote computers e.g. turn off remote 

computers, open webpage on remote computers...  
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Some of those actions can be used as restrictions - they are automatically started when 

remote user logs in:  
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Applications and Processes  
You can see which applications are currently running and stop them if needed. 

Application can be moved to a blocking list and it will be automatically stopped if user 

starts it.  

 

Here you can configure which applications will be blocked:  
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You can also see which processes are currently running and kill them if needed:  
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Desktop Recorder  

You can record remote users’ screens to MPEG4 or JPG files.  

Recording can be scheduled or started manually.  

Here you can also play recordings.  

Recordings can be optionally stored on a shared folder.  

We suggest that you uses hidden share e.g. \\mycomputer\recordingsXYZ$.  

Select this under "Desktop Recorder" - Override recordings directory.  

Share must have read/write access for logged user on remote computer -   therefore 

using hidden share is suggested since remote users will not know to access it.  
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Internet Control  
You can choose which web sites to allow and which to block:  

 

Advanced Blocking  

If option "Use Advanced Blocking" is selected, network blocking is done on a system 

kernel level that is independent on web browser.  

When using this option to allow specific web sites, you may need to allow also other 

sites from where original site is loading resources - e.g. images.  
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Messaging  
You can send a message or questions to remote computers:  
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Desktop Sharing  
You can share your screen or remote screen to others.  

Remote control can be enabled so remote users can control shared screen when 

needed:  
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Web Browsing, Application Usage Logging 

and Key-Logger  
Here you can see which web pages were opened by the users and which applications 

user was using the most. There are several reports available e.g. top web sites, details, 

key-logger shows keystrokes in each application...  

You can also filter report by computer, user, time range...  

Report can be exported to a file.  
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File Manager - Sending Files, Collecting 

Files  

Send Files  

Here you can send files to selected employee computers. Multiple files can be selected.  

There is also an option to automatically start / open sent files on employee computer.  

If file already exists you can choose to overwrite it.  

 

Collect Files  

Here you can collect files from employee computers. Files will be copied to selected 

target folder on computer with the console.  

Multiple files can be collected - you need to type them in filed "File(s) to collect". Files 

must be separated with ";" for console running on Windows or by ":" for console running 

on other operating systems.  

Files from different computers can be copied to different folders based on computer 

name, user name or time.  
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Remote Control  
Remote control can be started from object menu or from menu on specific remote 

computer screen:  
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Using Console for Mobile Phone or Tablet  
Console can be downloaded on appropriate application store: 

http://networklookout.com/downloads.htm 

Mobile console version operates very similar as desktop version. 

Add computers 

 

Before monitoring you need to add computers that you want to monitor. 

Find computers 

Find and add PCs where agent is installed  

Open the console on your smartphone or tablet and click on "Find computers ":  

 

On the next screen enter the agent's password that you choose in previous step when 

installing an agent.  

Tap on "Scan computers" button and wait few seconds that network PCs are 

discovered.  If nothing is discovered please check your WiFi connection and tap on 

"Scan computers" again.  

Please note that you can scan PCs only on your local network. If they are not 

discovered then you will need to add them manually (described in next chapter).  

http://networklookout.com/downloads.htm
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If they are discovered you can select which to add and then tap on "Add computers ".  

 

Manually add computers  

If PCs in previous step are on different network or were not automatically discovered 

you can add them manually by tapping on "Add computer ":  

 

On the next screen fill all required fields. Under Remote computer filed type IP or DNS 

host name of the network PC. Enter the agent’s password that you choose in first step 

when installing an agent.  

When everything is filled correctly tap on Done.  
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Computer list view  

All added PCs will appear in a list. You can select one computer by tapping it. If you 

want to select more computers you can use checkboxes. Computer list can be hidden 

by tapping on menu icon.  

 

Action menu  

Action menu can be used to invoke some specific actions on selected network 

computers. You can show the menu by tapping on Menu or by tap & hold on specific 

computer in a list.  
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Remote screens view  

Remote computer screens can be viewed using Remote screens view. On smartphones 

you will need to hide Computer list view first.  

 

Configuration menu can be displayed / hided by tapping a gear icon in upper right 

corner:  
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Tools view  

A several useful actions can be performed on remote computers. Before executing 

those actions make sure that you select desired computers in Computer list view .  

 

You can also start a program on remote computers – click on Start program tab:  
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Processes view  

You can see which processes and applications are running on remote computer. 

Processes list is displayed for highlighted computer in Computer list view .  

Processes list contain also checkboxes that can be selected to perform actions on a 

group of selected processes or applications.  

Process action menu can be displayed by using tap & hold on a specific process of by 

sliding left on a specific process.  

This menu allows you to close the application or kill the process.  
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Additional process actions can be performed using Stop menu by tapping upper right 

corner stop icon.  

Actions Kill process by name and Stop applications by name can be performed also on 

all selected computers simultaneously.  

 

Remote control  

You can also remotely control computers (mouse & keyboard). Chose action Remote 

control from action menu:  

 

On the displayed remote view you can control mouse by dragging displayed on screen 

mouse.  
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You can tap specific mouse buttons.  

You can also display a keyboard or display object menu where additional options are 

available (e.g. you can choose which monitor to control on multi-monitor systems).  

 

 

Find answers on most common questions  

 

What should I do if I can't see remote screens?  

The problem is usually caused by firewall or antivirus software. Windows automatically 

installs and enables firewall. Make sure that port TCP 4495 is open on remote 

computer's firewall.  

You can try to temporary disable a firewall on remote computer to see if this solves the 

connectivity problem.  

You can read more about enabling ports on Windows Firewall here:  

http://windows.microsoft.com/en-us/windows/understanding-firewall-

settings#1TC=windows-7  

Note that you may have more firewalls installed. Some antivirus programs automatically 

install the firewall. In this case you have to open port on all firewalls.  

http://windows.microsoft.com/en-us/windows/understanding-firewall-settings#1TC=windows-7
http://windows.microsoft.com/en-us/windows/understanding-firewall-settings#1TC=windows-7


 

Page | 37 

 

If you are still facing problems try to use IP instead of hostname when adding computer 

to the console.  

 

 

Why blocking web pages is not working?  

On Windows XP, Windows Vista, Windows Server 2003 or Windows Server 2008 you 

need to install update from this web page:  

http://support.microsoft.com/kb/971513  

Update has to be installed on all computers where agent is installed and is necessarily 

to successfully block web pages on various web browsers.  

 

Where recorded AVI files are stored?  

AVI files are located on remote computer in \dr subfolder where agent is installed. 

Network share for this folder can be created to play those files remotely.  

 

My Antivirus or Antispyware detected your application as dangerous.  

When our application become more popular, a lot of antispyware and antivirus 

programs started to recognize it as dangerous.  

Our application does not open any secret doors or anything similar - it just allows you to 

monitor other computers and this is enough for antivirus and antispyware production 

companies to flag it as dangerous.  

The only way to avoid this is to put the application on exclusion list.  

How to use the application over the Internet?  

Setup is highly dependent on your network configuration.  

If your remote computers have global IP then you can just open used TCP port 4495 on 

all firewalls and start using the application.  

http://support.microsoft.com/kb/971513
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If your remote computers are behind the router, then you will need to configure router 

also (port forwarding, virtual server NAT,... - depends on your network architecture).  

Agent acts as TCP server. You need to create a new virtual server on your router. Every 

user needs separate virtual server on different port. All those ports have to be forwarded 

to different local IP and to port 4495.  

When this is done you have to add computers to the console. Here you use your global 

IP or hostname for all computers, but you use different port that is equal to your 

forwarded port.  

If you don't have a static IP you can use some free dynamic DNS service like  

www.no-ip.com  

where you will receive a domain e.g.  

your_name.no-ip.biz  

that can be used instead of IP.  

A program from www.no-ip.com will automatically update a DNS when your IP is 

changed.  

The other more simple solution is to use VPN.  

Using VPN will solve all problems regarding NAT and dynamic/local IP addresses, since 

your network will look like a local network even when used over the internet. With 

Windows XP Professional VPN server is already included.  

 

What indicates the "Not authenticated" status?  

The "Not authenticated" status indicates that the password entered during agent 

installation is not the same as password used when adding the computer in the console.  

We suggest that you choose Properties in the console (for specific computer - click right 

mouse button) and enter the password again.  

You can also check the agent's passwords by opening agent configuration utility using 

your password.  

http://www.no-ip.com/
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If you forgot your agent's password, please uninstall agent using our installation 

package and install it again.  

Sometimes problem appear because of console's configuration file corruption. In such 

case you will have to delete the following folder (and add computers again):  

{folder where application is installed}\users  

or (on Windows Vista / Windows 7, 8, 10):  

C:\ProgramData\Net Monitor for Employees Pro\users  

Is the license permanent or it expires?  

License is permanent. It never expires. You don't need to renew the license.  

Can I order using Purchase Order (PO)?  

Yes, we accept Purchase Orders. Please send us a message where you mention the 

number of licenses you want to purchase, and we will send you detailed information on 

how to send a PO.  

 


